
 

 

 

 

 

 

Smart I/O 234 Error Detector 
   

 
 

User Manual 
 

 

 

 

 

 



 

 

CONTENTS 

Copyright & Notice................................................................................................................ 1 
Brief Introduction .................................................................................................................. 2 
Function Description.............................................................................................................. 2 
Package Contents................................................................................................................... 3 
Instruction Guide ................................................................................................................... 4 

I. I/O Host ...................................................................................................................... 4 
Description of Error Detector Main Functions Page ................................................ 5 

1. TEST .......................................................................................................... 5 
2. SETUP........................................................................................................ 6 
3. SPD ............................................................................................................ 6 
4. LEARN..................................................................................................... 11 
5. OPEN ....................................................................................................... 11 
6. SHORT..................................................................................................... 12 

II. Windows I/O 234 Recording Software.................................................................. 13 
Install USB to RS0232 driver ............................................................................... 13 
Install I/O 234 Testing Software ........................................................................... 13 
System Operation ................................................................................................. 15 
Part I .................................................................................................................... 16 

<File> Function ............................................................................................ 17 
<Pinout> function ......................................................................................... 17 
<Set up> Function......................................................................................... 18 
<Tool> Function ........................................................................................... 20 
<View> &<Window> Function..................................................................... 22 

Part II Test Setting ................................................................................................ 22 
Part III SPD testing............................................................................................... 25 

SPD functions on client:................................................................................ 25 
IO Testing functions on the Smart I/O: .......................................................... 27 
I/O Testing card: ........................................................................................... 27 

 

 



 

 1 

Copyright & Notice  
 
This user manual is protected by International Copyright, RamCENTER Technology 
Corporation reserve all rights, this user manual shall not be copied, altered nor transmitted   
without permission of the company. 
 
Our company shall alter the user manual without further notice. We apologize for any possible 
mistakes in this manual, and our company shall take no responsibility for the mistakes. 
 
Our company shows no guarantee for the manual content, quality, accuracy, and applicability. 
Thus, any direct or indirect damages caused by the manual, our company shall take no 
responsibility nor shall owe any compensation. 
 
This manual will be updated when needed, you are welcome to download the newest version 
from our website http://www.ramcenter.com.tw/. 
 
Our company will not provide warranty service for damage caused by any improper setting or 
use. 
 
All logos and product names mentioned in this manual, their copyright belong to the 
registered company. 
 
Contact Information 
 
RamCENTER Technology Corporation 

Address: 8F.-2, No.2 Jian 8th Rd., Zhonghe Dist., New Taipei City 23511, Taiwan (R.O.C.) 

Tel: 02-82269098 

Fax: 02-822669096 

E-mail: sales@ramcenter.com.tw
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<Smart I/O 234 Error Detector > 

Brief Introduction 
<Smart I/O 234 Error Detector > has multiple functions, the combination of simple operation 
interface, software and Smart I/O Error Detector allows users to experience higher speed and 
accuracy while using. 
 

Function Description 
<Smart I/O 234 Error Detector > provides the functions below: 

1. .Applicable for DDR2, DDR3, DDR4 modules. 

2. Able to run PCB cable Open/Short circuit functions on Smart I/O or through Windows 
system easily. 

3. Provide a single module SPD recode function. 

4. Wearable Error Detector allows you to use it anytime, anywhere. 

5. Easy to operate with clear LCD functional interface. 

6. Clear and easy understandable real-time display of module detecting status. 

7. With RamCENTER I/O testing system software (Windows interface), you can run Intel 
XMP for Overclocked Edtion, Compilation of Manufacturing Information, Auto-generate 
Serial Code Recoding and Date Code. 

8. RS-232 interface can be applied to RamCENTER I/O testing system (Windows interface) 
for other functional Expansion DIMM Sockets. 

9. I/O testing card help corresponding Adress and Date on the module when detecting 
OPEN/SHORT Circuit. 
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Package Contents 
 
Please check the package contents. If there is any device shortage, please connect us. The 
missing device will be delivered to you as soon as possible! 
 
 
 
 
 
 

 
 
 
 

 
 

Power supply Smart I/O Error Detector 

R
S-232 

Install Disc  
(include user manual) 

I/O Test Card 
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Instruction Guide  
 【Smart I/O 234 Error Detector】contains two parts: I. Smart I/O, II. Windows software interface. The 
following pages will explain the use of each part. 

 
I. I/O Host 

Smart I/O DIMM Sockets / Expansion DIMM Sockets 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

After powered up Smart I/O Error Detector, 6 functions will be shown on the LCD screen. Please choose 
the button by contrasting the screen: 

 

 

 
1. TEST ：Test the condition of the module. 
2. SETUP ：Setting mode of < Power Short Circuit >、<Cable Open Circuit>、<Cable Short 

Circuit>、< SPD Recode >、< SPD Verify> 
3. SPD ：Single module SPD function. 
4. LEARN ：Expansion Sockets module learning mode. 
5. OPEN ：Module OPEN circuit testing. 
6. SHORT ：Module SHORT circuit testing. 
 
 
 
 

TEST SETUP SPD LEARN OPEN SHORT 

I/O DIMM Sockets 

Expansion 
DIMM Sockets 
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Description of Error Detector Main Functions Page 

 
※ To run TEST, OPEN, SHORT functions, insert an OK module into the “Expansion DIMM Socket”, 

press <LEARN> to start the learning, then chose for TEST, OPEN and SHORT or other functions. 
 

(1)  

 

(2)  
 
※IO Host port can run a single module READ, COPY, VERIFY functions. Expansion DIMM Socket 

support LEARN, TEST, OPEN, SHORT, READ, COPY, VERIFY functions. 
 

1. TEST 

Insert the module into “Expansion DIMM Socket”, then press <TEST> to show the images below: 
 

 
 

(1)   

(2)  

(3)  

(4)  

(5)  
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2. SETUP 

Press <SETUP> on the home page to show the following image on Smart I/O screen: 

 
 

3. SPD 

Press <SPD> to run for a single module recording, and the screen will show the following image: 
 

 

READ 

Press <READ>, Smart I/O will read the SPD data from module, Smart I/O screen will show the 
following images: 
 

 

 

 
 
When shown the images above, press <AGAIN> to READ again. There is no need to return to <SPD> 
function page to restart the process. Press <SPD> to return to function page while finishing reading. 
 
If the module is not well inserted or EEPROM is damaged, press <READ> to show the images below, 
press <AGAIN> to READ again. Press <Exit> to return to <SPD> function page while finishing 
reading. 
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Press <COPY> to copy SPD data to the module, the following images will be shown: 

 

 

 

 
When the images above are shown, press <AGAIN> to <COPY> again. There is no need to return to 
<SPD> function page to restart the process. Press <SPD> to return to function page while finishing 
copying. 
 
If the module isn’t well inserted or EEPROM is damaged, press <COPY> to show the images below, 
press <AGAIN> to copy again. Press <Exit> to return to <SPD> function page while finishing 
copying. 
 

 

VERIFY 

Press <VERIFY>, Smart I/O will verify SPD data from the module, and the following images will be 
shown: 
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When the images above are shown, press <AGAIN> to <VERIFY> again. There is no need to return 
to <SPD> function page to restart the process. Press <SPD> to return to function page while finishing 
verifying. 
 
 
If the module is not well inserted or EEPROM is damaged, press <VERIFY> to show the images 
below, press <AGAIN> to verify again. Press <Exit> to return to <SPD> function page while 
finishing verifying. 
 

 

VIEW－MO-256、MO-512、TE-256、TE-512 

Press <VIEW> to show the SPD data which are saved in the Smart I/O: 
1. < MO-256>: Showing the SPD data of first 256 Byte in the module. 
2. < MO-512>：Showing the SPD data of last 256 Byte in the module. 
3. < TE-256>：Showing the SPD data of first 256 Byte in the I/O host. 
4. < TE-512>：Showing the SPD data of last 256 Byte in the I/O host. 
 

 

 

 
Press<DOWN> to move to the next page. To move to the previous page please press <UP>, the first 
button on the LEFT of <DOWN>. For exiting, press <EXIT> to return to the <SPD> function 
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page.  

 
 

SETUP－A_s/n、V_s/n、D_s/n、ROM_SIZE、CODE  

Press <SETUP> to setup for < A_s/n >, < V_s/n >, <D_s/n >, < ROM_SIZE >, <CODE> modes. 
Press the rightmost <EXIT> button to return to <SPD> function page, then press the rightmost <Exit> 
again to return to Smart I/O homepage. 
 
< A_s/n >: On and Off button of Auto-generate serial number function. 
 
 <ON>: Auto-generate serial number on 

 
  <OFF>: Auto-generate serial number off 

 
< V_s/n >: On and Off button of verifying serial number function.  
 

 
 

 
 

DOWN UP 
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<ON>: Verify all SPD data including serial numbers. Verify will fail when all SPD data are the same,  

but serial numbers are different. 
 

 
<OFF>: Verify all SPD data except serial number. Verify will success when all SPD data are the same  

and the serial numbers are different, because serial numbers are not included in the 
verification. 

 
< D_s/n >: Auto-generate serial number direction button. 
 
<H-L>: from high to low 

 
<L-H> from low to high 

 
 
<ROM_SIZE>: EEPROM capacity selection button. 
 
<By SPD>: Auto determine EEPROM capacity, 256MB or 512 MB. 
 

 
 
<ROM256>: The mandatory setting of EEPROM capacity is 256MB. 

 

  
 
<ROM512>: The mandatory setting of EEPROM capacity is 512 MB 
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<CODE>: Select for Decimal system (DEC) or Hexadecimal system (HEX). 
 

 

 

4. LEARN 

Insert an OK module into “Expansion DIMM Socket”, press <Learn> to start learning then run for 
TEST, OPEN and SHORT functions. 
 

(1)  

(2)  

5. OPEN 

Insert the module into “Expansion DIMM Socket”, press <OPEN> to estimate if the module is having 
an OPEN Circuit. 
 

(1)  
 
If it is having an OPEN circuit, find out which Address or Date is wrong according to the shown 
information. 
 

(2)  
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6. SHORT 

Insert the module into “Expansion DIMM Socket”, press <SHORT> to see if the module is having a 
SHORT Circuit. 
 

(1)  
 
If it is not having a SHORT Circuit, the following image will be shown. 

 

(2)  

 
If it is having a SHORT Circuit, find out which is wrong according to the shown information. 

 

(3)  
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II. Windows I/O 234 Recording Software 
 

Install USB to RS0232 driver 

USB to RS-232 converter cable is needed when installing this driver. 
 
Install <HL-340.EXE> from disc driver.  

 
 
 

Install I/O 234 Testing Software 

 
Choose <SETUP.EXE> from the installing disc to execute, the following images will be shown: 
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System Operation 

The following image will be shown while entering I/O 234 software. 

 

 

When entering the recoding system for the first 
time, users will be asked to set a code. After 
entering the system please log out then log in 
again. 

 

 

When users log in, a code is required, all function 
will be available only with a correct code. 

 

 

 

 

 

Please make sure the power of the Smart I/O is 
switched on before entering the system, if not, the 
image on the left will be shown: 
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According to different functions chosen on Windows homepage, the following will be explained them in 
3 parts： 

 

Part I 

 
Please check if the connecting port is well connected 
when entering the page. 
 
 

 
 

 
 

 
 Usually, RS-232 cable is preset as Com1. For USB to 
RS-232 converter cable, please check Device Manager for the 
COM port, as the shown image on the left: 
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<File> Function 

Description for the selected functions: 
 

 

New File: After opening a new file, SPD data can be edit from  
the homepage. 

 

 

 

 

 

Open File: Open a file, it supports 
for *.BIN and *SPD file format. 

 
 
 
 
 
 
 
 

 
 

<Pinout> function 
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IC Pinout and Module Pinout. 

 
 

 
 
 
 
 
 
 

 
 
 
 
 

<Set up> Function 

 
 
 

Communication: Choose the connecting port. 
 
 

 
 

 
 RS-232 cable is preset to be Com1. For USB to RS-232 converter cable, please check Device 

Manager for the COM port, as the following images show: 
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Code setting: Besides the first code setting, the code may be changed here. 
 

 

IO Test Setting 
 

 
 
SPD Function Set up 
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<Tool> Function 

 

 

 
 
1. Manufacturing Information 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. SPD Wizards 
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3. XMP View:                        
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 4. XMP Wizards: 
 
 
 

 
 
 
 
 
 
 
 
 

 

<View> Function                                     <Window> 
Function 

 

 
 
 
 

 

Part II Test Setting 

Choose different functions according to your needs: 
<Power Short Circuit>, <Cable Open Circuit>, <Cable Short Circuit>, <SPD Record>, <SPD Verify>, 
<Software Protect> 
 

After setting, press <SETTING> to save and return to the homepage, then choose <TEST> for further 
testing instructions. 
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To run testing, insert an OK module into the “Expansion DIMM Socket”, press <LEARN> on Smart 

I/O or click <LEARN> on the software to start the learning, then run for further instructions. 
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※ Press <TEST> to start testing. 
 

 

 
 
Choose <Status> to check the testing process records
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Part III SPD testing 

SPD functions on client: 

 
1. Write: Write in the SPD data from the module of Smart I/O shown on the client. The following 

images will be shown when writing success. 
 

 
 
 
 
 
 

 
 
Load Tester: Load the SPD data which are saved in client and show the detail information on  
the computer screen. The following images will be shown when loading success. 
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Load Module: Loading SPD data of module into PC Smart I/O and show the detail information. The 
following images when loading success. 

 
 
Error will be shown when the module is not well 
inserted or EEPROM is damaged: 
 
 
 
 

 
 
 
 
 
 
 
 

 
 

Verify: Verify if the SPD data on Smart I/O match to data on PC-side. 
 

Verify Successfully 
 

 
 
 

 Verify Failure 
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Clear (00): Clear SDP data on Smart I/O. 

 
 

Clearing Clear success 
 

 

 

 

 

IO Testing functions on the Smart I/O: 

1. READ: Read the SPD data from module which is inserted in Smart I/O Error Detector and save  
the data in the host. 

2. COPY: Copy SPD data from Smart I/O Error Detector to the module 
3. VERIFY: Verify SPD data recorded from Smart I/O Error Detector with the SPD data from the 

module. 
4.LEARN: Learn the mode of <Open Circuit> and <Short Circuit> on the module from Expansion 

Slot.  
 
 

I/O Testing card: 

I/O Testing card help corresponding Address and Date on the module while running OPEN/SHORT 
functions. 

 
 


